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Executive Summary

More than 500 employers reported a seasonally adjusted Net Employment Outlook 

(NEO) of 13% as they forecast Q2 staffing changes in the latest edition of the 

ManpowerGroup Employment Outlook Survey.

*Net Employment Outlook results range from +100% to –100%

The Q2 2026 Belgian Net Employment 

Outlook decreased since the 

previous quarter (-2 points) 

and year-over-year (-11). 

Anticipated hiring 
increases are driven 

by company 
expansion.

Expected decreases are 

driven by economic 

challenges.

Strongest & Weakest NEOs by SectorBy Regions
Reported for Q2 2026

19%
Flanders Brussels

10%
Wallonia

13% 34%
Hospitality

1%
Finance & Insurance
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Q2 Employer 
Hiring Sentiment
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No Change

How will your 

staff size 

change next 

quarter?*

Decrease

Increase Unsure

Capturing Future 
Hiring Plans

Since 1962, ManpowerGroup has asked 

organizations about their quarterly hiring plans. 

More than 41,700 employers across 42 

countries reported hiring expectations 

for Q2 2026 in the latest edition of the 

Employment Outlook Survey.

Respondents shared whether their staffing 

levels would remain unchanged, increase 

through new hiring, or decrease due to layoffs 

or anticipated departures.

*The survey question has been modified for clarity, and the full text is available in the About the Survey section.
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2% of employers were unsure 

how staffing levels would change 

in the months ahead.

53% of employers said they 

planned to keep staffing levels 

unchanged.

16% of employers reported they 

are anticipating staff reductions.

29% of employers said they 

planned to increase their staff 

between April and June.

How will your 

staff size 

change next 

quarter?*

Employer Expectations in Belgium



Employer Hiring Sentiment Workforce Trends About the Survey

Q2 2026 
Belgian NEO*

Anticipate 
Staffing Increase

Anticipate 
Staffing Decrease

Measuring With the Net Employment Outlook

Hiring sentiment is quantified using the Net Employment Outlook (NEO), defined as the difference between the 

percentage of employers planning to increase staff and those planning to reduce staff.

The unadjusted NEO for the second quarter of 2026 is 13%. After adjusting for predictable seasonal patterns, and 

to more accurately compare across regions and over time, the NEO is 13%. The seasonally adjusted figure is used 

throughout the remainder of this report unless otherwise noted.
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*Net Employment Outlook results range from +100% to -100%

13%29% 16%



Employer Hiring Sentiment Workforce Trends About the Survey 7

Changes Over Time - Belgium

2020 2021 2022 2023 2024 2025 2026
-5%
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20%

25%

30%

35%

40%

NEOs for Q2 in Belgium has decreased by 1 point since the previous quarter and by 12 points when compared to the same 

time last year.

13%
Q2 2026 

Belgian NEO*
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Strongest NEO

Hiring Expectations by Region - Belgium
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Employers in Flanders reported the strongest Net Employment Outlook for Q2 2026, while hiring intentions have 

decreased in all three regions compared to the same period last year. Only in Wallonia has the NEO increased (by 6 

points) since last quarter.

13%

Belgium

19%

Flanders

10%

Brussels

13%

Wallonia

- 11 pts YoY - 11 pts YoY- 9 pts YoY - 9 pts YoY
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Outlooks Across 
Key Industry 
Sectors in 
Belgium

Hospitality employers reported 

the highest NEO, while 

Finance & Insurance and 

Public Sector, Health & 

Social Services reported the 

lowest.

1%

1%

6%

8%

11%

12%

25%

27%

34%

0 pts YoY

- 17 pts YoY

Hospitality

Construction & Real Estate

Information

Professional, Scientific and Technical Services

Trade & Logistics

Public Sector, Health & Social Services

Utilities & Natural Resources

Manufacturing

Finance & Insurance

Most 

Decreased 

NEO YoY

- 1 pts YoY

- 45 pts YoY

- 16 pts YoY

- 27 pts YoY

- 8 pts YoY

- 6 pts YoY

- 23 pts YoY
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Strongest NEO

Hiring Expectations by Company Size
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Organizations with 250-999 employees reported the most positive NEO for Q2 2026, while those with less than 10 

employees anticipated the strongest improvement since the same time last year.

16%

Less than 10 
Employees

13%

10 - 49 
Employees

20%

50 - 249 
Employees

18%

250 - 999 
Employees

3%

1,000 - 4,999 
Employees

0%

5,000+
Employees

- 6 pts YoY - 11 pts YoY- 7 pts YoY - 9 pts YoY - 11 pts YoY - 23 pts YoY

Most decreased  NEO
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Hiring Expectations for April – June by Country

Employers in India 

reported the strongest 

quarterly NEO

improvement (+16 pts).
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U.A.E.* 60%

Brazil 55%

Vietnam* 47%

Panama 44%

Costa Rica 43%

Mexico 41%

Sweden 39%

U.S. 38%

The Netherlands 37%

Peru 37%

Chile* 36%

Ireland 36%

Guatemala 34%

India 68% Australia 33%

Puerto Rico* 32%

Poland 31%

China 29%

Israel 29%

Taiwan 29%

Spain 28%

U.K. 27%

Canada 24%

Singapore 24%

Argentina 23%

Portugal 29%

Türkiye 22%

Norway 21%

Greece 20%

Colombia 18%

Germany 18%

Hungary 18%

Switzerland 18%

Japan 17%

Finland 15%

France 15%

Belgium 13%

Czech Republic 13%

Italy 22%

Hong Kong 11%

Romania -5%

Slovakia 3%

*The NEOs for Chile, Puerto Rico, the U.A.E., and Vietnam are currently unadjusted and will be seasonally adjusted after sixteen quarters of data.

31%
Global Average
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Year-Over-Year Changes by Country

*The NEOs for Chile, Puerto Rico, the U.A.E., and Vietnam are currently unadjusted and will be seasonally adjusted after sixteen quarters of data.
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The Netherlands

37%

Sweden

39%

Strongest NEO

U.A.E.*

60%

13

Hiring demand across the region is driven by employers in:

Organizations with 
250-999 employees

28%

Construction & 
Real Estate

30%

The NEO in Europe and the Middle East improved since the previous quarter (+3 pts) and year-over-year (+4).

Employment Outlooks Across Europe and the Middle East

*The NEOs for Chile, Puerto Rico, the U.A.E., and Vietnam are currently unadjusted and will be seasonally adjusted after sixteen quarters of data.
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About the Survey
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About the Survey

The ManpowerGroup Employment Outlook Survey is the most comprehensive, forward-looking employment 

survey of its kind, used globally as a key economic indicator. The Net Employment Outlook is derived by taking the 

percentage of employers anticipating an increase in hiring activity and subtracting from this the percentage of employers 

expecting a decrease in hiring activity. Running since 1962, various factors underpin the success of the Survey:
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Forward-Looking Statements –
This report contains forward-looking statements, 

including statements regarding labor demand in 

certain regions, countries and industries, and 

economic uncertainty. Actual events or results 

may differ materially from those contained in the 

forward-looking statements, due to risks, 

uncertainties and assumptions. These factors 

include those found in the Company's reports filed 

with the U.S. Securities and Exchange Commission 

(SEC), including the information under the heading 

"Risk Factors" in its Annual Report on Form 10-K for 

the year ended December 31, 2025, whose 

information is incorporated herein by reference. 

ManpowerGroup disclaims any obligation to update 

any forward-looking or other statements in this 

release, except as required by law.

Unique – It is unparalleled in its size, scope, longevity and area of focus. The ManpowerGroup Employment Outlook 

Survey is the most extensive, forward-looking employment survey in the world, asking employers to forecast employment over 

the next quarter. In contrast, other surveys and studies focus on retrospective data to report on what occurred in the past.

Independent – The survey is conducted with a representative sample of employers from throughout the countries and 

territories in which it is conducted. The survey participants are not derived from ManpowerGroup’s customer base.

Robust – The Q2 2026 survey is based on interviews with 41,764 public and private employers across 42 countries to 

measure anticipated employment changes and trends. This sample allows for analysis to be performed across specific sectors 

and regions to provide more detailed information. 

Focused – For more than six decades the survey has derived all its information from a single question (Q2 2026 example): 

“How do you anticipate total employment at your location to change in the three months to the end of June 2026 as compared to

the current quarter?"

Survey Methodology – Survey responses were collected from 1 January - 3 February 2026. The size of 

organizations and sectors are standardized across all countries to allow international comparisons.
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What is meant by Net Employment Outlook (NEO)?
The Net Employment Outlook is derived by taking the percentage of employers anticipating 

an increase in hiring activity and subtracting from this the percentage of employers that 

expect to see a decrease in employment at their location in the next quarter. A positive Net 

Employment Outlook figure means that, on balance, there are more employers who expect 

to add to their headcount in the following three months than those who intend to reduce staff.

What is Seasonal Adjustment and why is it used in the 

ManpowerGroup Employment Outlook Survey?
Seasonal adjustment is a statistical process that allows the Survey data to be presented 

without the impact of hiring fluctuations that normally occur through the course of the year, 

usually as a result of various external factors, such changes in weather, traditional production 

cycles, and public holidays. Seasonal adjustment has the effect of flattening peaks and 

smoothing troughs in the data to better illustrate underlying employment trends and provide 

a more accurate representation of the ManpowerGroup Employment Outlook Survey results.

How are companies selected for 

the survey?
Employers are selected based on the types of companies and 

organizations they represent. We want to ensure that our panel 

is representative of each participating country’s national labor 

market, so each country’s panel is built in proportion to that 

country’s overall distribution of industry sectors and 

organization sizes.

Who do you interview in each company?
The person we select to interview will be someone with a good 

overview of staffing levels and hiring intentions within their 

organization. Normally this will be the head of HR or an HR 

manager. However, in smaller organizations, that person may 

be a general manager or even the CEO.

Frequently Asked Questions
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Industry Sectors Defined

Beginning with the Q1 2026 survey, the industry sectors have been updated to align with the North American Industry 

Classification System (NAICS). Historical data has been reclassified and will still be available as defined below.
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Construction & Real Estate:  Construction; Real Estate; Building Products; Construction & Engineering; Trading Companies & Distributors; Other Industrials Sub-Industry; Construction 

Materials; Real Estate Management & Development; Construction of Buildings; Heavy and Civil Engineering Construction; Specialty Trade Contractors; Rental and Leasing Services; and Lessors of 

Nonfinancial Intangible Assets.

Finance and Insurance:  Banking, Finance and Insurance; Banks;  Thrifts & Mortgage Finance; Diversified Financial Services; Consumer Finance; Capital Markets; Mortgage Real Estate 

Investment Trusts; Insurance; Equity Real Estate Investment Trusts; Other Financials & Real Estate Sub-Industry; Monetary Authorities-Central Bank; Credit Intermediation and Related Activities; 

Securities, Commodity Contracts, and Other Financial Investments and Related Activities; Insurance Carriers and Related Activities; Funds, Trusts, and Other Financial Vehicles.

Hospitality: Leisure Facilities, Gaming & Casinos; Accommodation, Restaurants, Hotels, Resorts & Cruise Lines; Arts, Entertainment, and Recreation; Accommodation and Food Services

Information:  Software; Communications Equipment; Technology Hardware, Storage & Peripherals; Other IT Sub-Industry; Diversified Telecommunication Services; Wireless Telecommunication 

Services; Media and Publishing; Entertainment; Interactive Media & Services; Other Communication Sub-Industry; Motion Picture and Sound Recording Industries; Newspaper, Periodical, Book, and 

Directory Publishers; Software Publishers; Broadcasting and Content Providers; Telecommunications; Computing Infrastructure Providers, Data Processing, Web Hosting, and Related Services; Web 
Search Portals, Libraries, Archives, and Other Information Services. 

Manufacturing: Manufacturing; Aerospace & Defense; Electrical Equipment; Machinery; Chemicals; Other Materials Sub-Industry; Electronic Equipment, Instruments & Components; 

Semiconductors & Semiconductor Equipment; Industrials Manufacturing; Energy & Utilities Manufacturing; Materials Manufacturing; Transportation Manufacturing; Consumer Goods & Services 

Manufacturing; Health Care & Life Sciences Manufacturing; IT Manufacturing; Communication Services Manufacturing; Other Manufacturing; Food Manufacturing; Beverage and Tobacco Product 

Manufacturing; Textile Mills; Textile Product Mills; Apparel Manufacturing; Leather and Allied Product Manufacturing; Wood Product Manufacturing; Paper Manufacturing; Printing and Related Support 

Activities; Petroleum and Coal Products Manufacturing; Basic Chemical Manufacturing; Resin, Synthetic Rubber, and Artificial and Synthetic Fibers and Filaments Manufacturing; Pesticide, Fertilizer, 

and Other Agricultural Chemical Manufacturing; Pharmaceutical and Medicine Manufacturing; Paint, Coating, and Adhesive Manufacturing; Soap, Cleaning Compound, and Toilet Preparation 
Manufacturing; Other Chemical Product and Preparation Manufacturing; Plastics and Rubber Products Manufacturing; Nonmetallic Mineral Product Manufacturing; Primary Metal Manufacturing; 

Fabricated Metal Product Manufacturing; Machinery Manufacturing; Computer and Peripheral Equipment Manufacturing; Communications Equipment Manufacturing; Audio and Video Equipment 

Manufacturing; Semiconductor and Other Electronic Component Manufacturing; Navigational, Measuring, Electromedical, and Control Instruments Manufacturing; Manufacturing and Reproducing 

Magnetic and Optical Media; Electrical Equipment, Appliance, and Component Manufacturing; Motor Vehicle Manufacturing; Motor Vehicle Body and Trailer Manufacturing; Motor Vehicle Parts 

Manufacturing; Aerospace Product and Parts Manufacturing; Railroad Rolling Stock Manufacturing; Ship and Boat Building; Other Transportation Equipment Manufacturing; Furniture and Related 
Product Manufacturing; Miscellaneous Manufacturing.
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Industry Sectors Defined Continued
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Professional, Scientific & Technical Services: Professional, Scientific and Technical Activities; Commercial Services & Supplies; Professional Services; Specialized Consumer Services; 

IT Services; Administrative and Support Services; Legal Services; Accounting, Tax Preparation, Bookkeeping, and Payroll Services; Architectural, Engineering, and Related Services; Specialized 

Design Services; Computer Systems Design and Related Services; Management, Scientific, and Technical Consulting Services; Scientific Research and Development Services; Advertising, Public 

Relations, and Related Services; Other Professional, Scientific, and Technical Services; Management of Companies and Enterprises.

Public Sector, Health & Social Services:  Education; Human Health and Social Work; Government (National or Local) or Public Service; Education Services; Health Care Equipment & 

Supplies; Health Care Providers & Services; Health Care Technology; Biotechnology; Pharmaceuticals; Life Sciences Tools & Services; Other Health Care & Life Sciences Sub-Industry; Not for Profit / 
Charity / Religious Organization; Educational Institutions; Educational Services; Health Care and Social Assistance; Other Services (except Public Administration); Public Administration.

Trade & Logistics: Wholesale and Retail Trade; Repair of Vehicles; Containers & Packaging; Paper & Forest Products; Air Freight & Logistics; Airlines; Marine; Road & Rail; Transportation 

Infrastructure; Auto Components; Automobiles; Other Transport, Logistics & Automobiles Sub-Industry; Household Durables; Leisure Products; Textiles, Apparel & Luxury Goods; Distributors; Online & 

Direct Marketing Retail; Multiline Retail (Department Stores, etc.); Specialty Retail (Apparel, Technology, etc.); Other Consumer Discretionary Goods & Services Sub-Industry; Food & Staples Retailing; 

Beverages; Food Products; Tobacco; Household Products; Personal Products; Other Consumer Staples Sub-Industry; Motor Vehicle and Motor Vehicle Parts and Supplies Merchant Wholesalers; 

Furniture and Home Furnishing Merchant Wholesalers; Lumber and Other Construction Materials Merchant Wholesalers; Professional and Commercial Equipment and Supplies Merchant Wholesalers; 

Metal and Mineral (except Petroleum) Merchant Wholesalers; Household Appliances and Electrical and Electronic Goods Merchant Wholesalers; Hardware, and Plumbing and Heating Equipment and 
Supplies Merchant Wholesalers; Machinery, Equipment, and Supplies Merchant Wholesalers; Miscellaneous Durable Goods Merchant Wholesalers; Paper and Paper Product Merchant Wholesalers; 

Drugs and Druggists' Sundries Merchant Wholesalers; Apparel, Piece Goods, and Notions Merchant Wholesalers; Grocery and Related Product Merchant Wholesalers; Farm Product Raw Material 

Merchant Wholesalers; Chemical and Allied Products Merchant Wholesalers; Petroleum and Petroleum Products Merchant Wholesalers; Beer, Wine, and Distilled Alcoholic Beverage Merchant 

Wholesalers; Miscellaneous Nondurable Goods Merchant Wholesalers; Wholesale Trade Agents and Brokers; Motor Vehicle and Parts Dealers; Building Material and Garden Equipment and Supplies 

Dealers; Food and Beverage Retailers; Furniture, Home Furnishings, Electronics, and Appliance Retailers; General Merchandise Retailers; Health and Personal Care Retailers; Gasoline Stations and 
Fuel Dealers; Clothing, Clothing Accessories, Shoe, and Jewelry Retailers; Sporting Goods, Hobby, Musical Instrument, Book, and Miscellaneous Retailers; Air Transportation; Rail Transportation; 

Water Transportation; Truck Transportation; Transit and Ground Passenger Transportation; Pipeline Transportation; Scenic and Sightseeing Transportation; Support Activities for Transportation; Postal 

Service; Couriers and Messengers; Warehousing and Storage.

Utilities & Natural Resources: Mining and Quarrying; Electricity, Gas and Air Conditioning Supply; Water Supply; Sewerage, Waste Management and Remediation Activities; Energy 

Equipment & Services; Oil, Gas & Consumable Fuels; Electric Utilities; Gas Utilities; Multi-Utilities; Water Utilities; Waste Remediation; Independent Power and Renewable Electricity Producers; Other 

Energy and Utilities Sub-Industry; Metals & Mining; Agriculture and Fishing; Agriculture, Forestry, Fishing and Hunting; Oil and Gas Extraction; Mining (except Oil and Gas); Support Activities for Mining; 

Utilities; Waste Management and Remediation Services.
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Appendix

Do not Include in the Report.



Colors in the 2026 MEOS Reports

Do not change graphic or text colors from their 
original state.

– The 2026 MEOS PowerPoint templates use additional 

colors to enhance the overall design. 

– Backgrounds, charts and text colors have been 

purposefully applied and tested for accessibility.

– Do not add new tint shades, standard colors or recent 

colors when localizing the report.



Saving the MEOS Report as a PDF

Exporting your interactive PDF:

– Delete the Appendix (slides 32-36).

– Mac: File > Save a Copy… > File Format > PDF

– PC: File > Save a Copy… > More options > PDF

– Rename and save the document as PDF.

PC

Mac



Industry Vertical Icons

Construction & 

Real Estate

Finance & 

Insurance

Hospitality Information Manufacturing Professional, 

Scientific & 
Technical 

Services

Public Sector, 

Health & Social 
Services

Trade & Logistics Utilities & Natural 

Resources



Country Flag Icons

Argentina Australia Belgium Brazil Canada Chile China

Colombia Costa Rica
Czech 

Republic
Finland France Germany

Global 

Average

Greece Guatemala Hong Kong Hungary India Ireland Israel

Italy Japan Mexico Norway Panama Peru Poland

Portugal Puerto Rico Romania Singapore Slovakia Spain Sweden

Switzerland Taiwan
The 

Netherlands
Türkiye U.K. U.S. U.A.E

Vietnam


